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Introduction 
 
With QTRAK version 3.3.2, QTRAK Mail forms can now use MS Word as an editor. This gives 
users the full functionality of MS Word for formatting when creating mail in QTRAK.  
 
The decision to use MS Word as an editor is made on a per Mail Type per Project basis and 
applies to all users within the project. 
 
Note that only MS Word 2000 and MS Word XP are supported. MS Word 97 is not supported. 
 
The way that this new feature in QTRAK works in summary is: 
 

• Define via Mail Type Rules which mail types you want to use MS Word with. 
• Create the required Word Template using MS Word 
• Then when creating mail in QTRAK of a type that is linked to Word, the mail details are 

completed as normal in QTRAK and when ready a button within the mail form to open 
Word is clicked. 

• The Word Template, populated with the details entered in QTRAK is opened and the 
body text is completed using the full functionality of Word. 

• When done, the mail is printed from MS Word 
• Then MS Word is closed and QTRAK manages the saving of the word document 

automatically.  
• The Body text typed in Word is copied automatically back into QTRAK (minus the 

formatting) to enhance search capabilities later. 
 
The process for creating mail templates in summary is: 
 

(a) Copy the standard MS Word template provided with QTRAK to a new file called Mail 
Type.dot (for example Letter.dot) if you were doing this for a Letter mail type. 

(b) Modify the template to suit your required format. (This FAQ is intended to explain how to 
create and modify these mail templates in word). 

(c) Now you define in QTRAK that you want to use MS Word with this mail type. 
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Creating a custom MS Word Template 
 
In the instructions below, we have assumed you are going to make a Word Template for use 
with Letters in QTRAK. 
 
Getting Started 
 
First you need to find out the mail type abbreviation used in your copy of QTRAK for Letters. 
Open QTRAK and select the Master Document Register. Click on the Show button and select 
Letters. Now in the Type column in the MDR you will see the mail type abbreviation. Lets 
assume this is LETTER. 
 
Now you need to copy the default word template provided with QTRAK to LETTER.Dot. To do 
this, open windows explorer and in the QTRAK folder, locate the file TrWdTemplate.Dot. This is 
a standard template that can be used as the basis for your own word templates. Copy this file to 
a file called LETTER.Dot. 
 
Now run MS Word 2000 or XP and open the file called LETTER.Dot from within the QTRAK 
folder. This will open the file as Letter.dot 
 
Note that you must not open this template document by double clicking on it from within 
Windows explorer.  
 
The word templates are always protected so you need to unprotect it to make changes: 
 
From the Tools menu, select Unprotect Document. 
 
Type the password to unprotect the template which for this first template is QtrakMSWordLink. 
This is case sensitive and must be typed exactly as written above. Later you will change the 
passwords used  so that the templates cannot be changed by unauthorised people. 
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How the Templates work 
 
The Templates work by using three features of Word. These are Sections, Bookmarks and 
Protection. 
The Template must be divided into a minimum of three sections. The first and last sections are 
always protected which means that the information in these sections is populated from QTRAK 
and cannot be changed while the user is creating mail in Word. The middle section is always 
unprotected and is where the user types their text.  How QTRAK knows where to put the data 
entered into the mail form when open MS Word is controlled by Bookmarks. 
 
For example, your Letter may be designed as follows: 
 
 
 

YOUR LOGO 
Your Address Line 1 
Your Address Line 1 

Etc 
 
Reference 
 
Date 
 
To Company 
To Person 
To Person Address Line 1 
To Person Address Line 2 
Etc 
 
 
Dear Person 
 
Re: Subject 
 
 
This is the body Text. This is the body Text. This is the body Text. This is the body Text. This is the body 
Text. This is the body Text. This is the body Text. This is the body Text. This is the body Text. This is the 
body Text. This is the body Text. This is the body Text. This is the body Text. This is the body Text. This is 
the body Text. 
 
 
 
 
 
Yours sincerely, 
 
 
From Person 
From Company 
 
 
 
 
The information in the above that comes from the Project Details, the mail header etc finds it’s 
way into the Word Template via Bookmarks that have been positioned in the mail template to 
match the QTRAK field names. 
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would come from 
the Project Details. 

This information 
would come from 
the mail header. 

SE
C

TI
O

N
 2

   
   

  
(U

n-
Pr

ot
ec

te
d)

 
SE

C
TI

O
N

 3
 

(P
ro

te
ct

ed
) 

This information 
would come from 
the Address Book. 

This information is 
typed in MS Word 
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The Word Template Letter.doc to achieve the above could look as shown below: 
 
 

 
 
 

Working with Bookmarks  
 
A bookmark in MS Word identifies a location or a selection of text. QTRAK uses bookmarks in 
the MS Word templates to identify the start and end of a field in the Word Template, so it can 
update the field with the value from the Mail form in QTRAK when MS Word is launched through 
QTRAK.  

Text in red is are 
comments and are 
replaced with 
values from QTRAK 
when the template 
is used. 

Note that for each 
value there is a start 
and end bookmark. 
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How to view the locations of Bookmarks: 
 
To view the locations of the bookmarks added in the template/ document, follow the below 
steps. 
 

1. On the Tools menu, click Options 
 
2. Click on View tab 

 
3. Tick the Bookmarks check box under Show 

 
4. Click OK 

 
In order to hide the bookmarks, follow above steps and un-tick the Bookmarks check box at 
step 3. 
 
How to add a Bookmark: 
 

1. Click where you want to insert a bookmark.  
 
2. On the Insert menu, click Bookmark.  

 
3. Under Bookmark name, type or select a name.  

 
Bookmark names must begin with a letter and can contain any combination of letters & 
numbers. You can't include spaces in a bookmark name. However, you can use the 
underscore character to separate words — for example, "First_heading." 
 
NOTE: The bookmark name format should named as per the QTRAK Standard 
Bookmark naming convention as described in the appendix to this FAQ. 
 

4. Click Add 
 
 
Note, to edit or check the value of an existing bookmark, with your mouse positioned just to the 
right of the bookmark, use the Insert\Bookmark option as for adding new bookmarks. 
 
 
Putting Bookmarks into Use: 
 
Say you wanted in your template to have an area that printed the name of the person the mail 
was addressed to. (This information is something you populate when completing the mail form in 
QTRAK).  
 
In the word document you would want this to look like: 
 
To: NAME  
 
Where “To:” is a caption and “NAME” is the TO Persons first and last name. 
 
To do this, first you have to work out the name of the bookmarks to use. In the Appendix of this 
FAQ you can find out that the Bookmarks for the TO Persons first and last name are: 
 

bkm_TOFNLN_begin   which is used to indicate where the name is to start from. 
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Bkm_TOFNLN_end  which is used to indicate where to name is stop. 
 

Hence in the word template you would 
 
a) First type in the correct location the caption you want to appear which in this case is: 

 
To:  
 
Where “To:” is going to be the caption. 
 

b) Then to the right of the colon, Click the Insert menu and select Bookmark. 
 

c) Type the Bookmark Name as bkm_TOFNLN_begin  and click Add 
 

d) Now press space and type “[To  First Name + Last Name]” 
 

Note that this step is optional as this text will be replaced with the To person name 
when the template is used but it lets the person maintaining the template see what 
the value is without having to edit the book marks. Note that any text between a 
begin and end book mark is replaced when the template is used via QTRAK. 

 
e) Now press the space bar a couple of times. Please ensure that the spaces provided 

should be at least 3 or more and not less. Then again select Insert \ Bookmark. 
 

f) Type the Bookmark as Bkm_TOFNLN_end and click Add 
 
 
In the appendix of this FAQ are a list of the standard bookmark names for use with QTRAK. 
These are standard fields from the Project details, address book and mail header. 
 
To put custom fields (fields from the mail details part of the mail form in QTRAK) into your word 
template, you will need to find out the names of these fields from QA Software. 
 
Note also that for the Bookmarks for the body text, normally bkm_RfMail_Details_begin and 
bkm_RfMail_Details_end, it is recommend to put the bkm_RfMail_Details_end book mark as the 
first line in the protected section below the section the begin bookmark is in. 
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Using Section Breaks 
 
Sections in the Word templates separate the areas of the template where the user will be able to 
type from areas that are protected. 
 
There must be at least 2 sections in each template. Normally there are at least 3 sections. 
Section 1 for the header, Section 2 for the user to type in, and Section 3 for the protected footer. 
 
To see the existing section breaks, click the Show/Hide Format codes icon on the Word toolbar 
(Show/Hide ¶). 
 
How to insert a section break: 

 
1. Click where you want to insert a section break.  
 

NOTE: For templates to be used in QTRAK Wordlink, this position will normally be the 
end of the Mail header [Section1] and the end of the Details section [Section 2].  

 
2.  
3. On the Insert menu, click Break.  

 
4. Under Section break types, click the option that describes where you want the new 

section to begin. 
 

NOTE: For templates to be used in QTRAK Wordlink, the ‘Continuous’ Section Break 
Type will be used.  

 
Now in each section you insert the necessary text, bookmarks, captions etc. 
 
 

Protecting the Template 
 
Once you have set up your template, it must be protected. This is to ensure that the fields in the 
template that are automatically from QTRAK can not be edited when the Word template is 
launched through QTRAK. 
 
The template should be protected just prior to you wanting to use it (ie after you have inserted 
your fields and bookmarks and prior to you wanting to try it out). 
 
How to protect the section breaks 
 

1. On the Tools menu, click Protect Document.  
 
2. Click Forms.  

 
3. Click Sections, and then clear the check boxes of the sections you don't want to protect 

and click OK. 
 

For templates to be used in QTRAK Wordlink, Section 2 has to be un-ticked in order to 
enable a user to enter details 
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4. Assign a password to protect the selected sections. 
 
NOTE: Passwords are case sensitive. 

 
5. Click OK.  

 
IMPORTANT: Once the sections are password protected, these section will not be editable 
until they are unprotected. As QTRAK will be updating these protected sections 
automatically with the Mail table fields this password has to also be specified in QTRAK Mail 
Type Rules under Admin menu or the template cannot be used by QTRAK. 

 

Saving the MS Word Template 
 
Once all the required steps are completed save the file as Word Template by clicking save and 
closing. Note that this is only possible if you opened the template from within Word. If you 
double clicked the template to open it you will have to use File\Save As to save and will have to 
choose a temporary file name eg LetterNew.Dot and then within windows explorer, locate 
QTRAK\Letter.dot and remove it and rename LetterNew.Dot to Letter.Dot. The template name 
must match the QTRAK mail type abbreviation. 
 
 
Eg SI.DOT for Site Instructions, RFI.DOT for Requests for Information. 
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Setting up QTRAK to use the Word Template 
 
1. Log on to QTRAK 
 
2. On the Tools menu, click Mail Type Rules. 
 
3. Select a mail type. 
 
4. Click on  (edit) button. 
 
5. Click on Work Flow tab 
 
6. Select the option to use MS Word as the editor. 
 
7. Click on Set Password for Word Templates button. (This will be disabled if ‘Use MS Word’ 

is not selected as the formatting option for outgoing mail) 
 
8. Enter the password and re-confirm. Note that they are case sensitive. This password must 

be EXACTLY the same as that used when protecting the word template above. 
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Appendix 1:  QTRAK Standard Bookmark Naming Convention 
 
There should be 2 bookmarks (one to indicate the start position of the field and the other to 
indicate the end position of the field) to identify a field location in Word document, so that the 
value from the mail table can be inserted into the Mail Template. 
 
QTRAK uses the following naming convention: 
 
Bkm_Table_Field_X 
 
Where: 
 
Bkm is fixed 
Table is the name of the table the field exists in within QTRAK  
Field is the name of the field in the QTRAK table 
X is either “begin” or “end” to control the start and finish of the field in the word template. 
 
For example, the reference number for an item of mail is stored in a field called “Reference” in a 
table called “RfMail”. Hence the bookmark names to position the start and end of the Reference 
number in the word template are: 
 
bkm_RfMail_Reference_begin 
bkm_RfMail_Reference_end 
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Appendix 2: Reserved Bookmark names  
 
The following bookmark names are reserved bookmark names for standard fields in QTRAK which can be 
used in any custom Word templates to populate the corresponding values from the Mail form. 
 
A. Bookmarks names to Mail Header Details 
 
Description Bookmarks 
To print the Reference Number 
 

Bkm_RfMail_Reference_begin 
Bkm_RfMail_Reference_end 

To print the Date 
 

Bkm_RfMail_Dated_begin 
Bkm_RfMail_Dated_end 

To Print the Status values 
 

Bkm_RfMail_Status_begin 
Bkm_RfMail_Status_end 

To Print the Subject 
 

Bkm_RfMail_Subject_begin 
Bkm_RfMail_Subject_end 

To Print the Respond By Date 
 

Bkm_RfMail_RespondBy_begin 
Bkm_RfMail_RespondBy_end 

To Print the Responded Date 
 

Bkm_RfMail_Responded_begin 
Bkm_RfMail_Responded_end 

To Print a list of Links 
 

Bkm_pcmlLink_begin 
Bkm_pcmlLink_end 

To Print a list of Attachments 
 

Bkm_pcmlAttach_begin 
Bkm_pcmlAttach_end 

To Print a list of Actions 
 

Bkm_pcmlAction_begin 
Bkm_pcmlAction_end 

To Print a List of Binder and Section Ids 
 

Bkm_pcmlBndLnkID_begin 
Bkm_pcmlBndLnkID_end 

To Print a list of Binder and Section Ids + Titles 
 

Bkm_pcmlBndLnk_begin 
Bkm_pcmlBndLnk_end 

 
 
B. Bookmarks names to get TO and CC details 
 
Description Bookmarks 
To print the multiple TO persons details in the following format:  
1st To Person FirstName+ “ “+LastName 
2nd To Person FirstName+ “ “+LastName 
 

Bkm_TOFNLN_begin 
Bkm_TOFNLN_end 

To print the multiple TO persons details in the following format: 
1st To Person Title + “ “ + FirstName + “ “+ LastName 
2nd To Person Title + “ “ + FirstName + “ “+ LastName 
 

Bkm_TOTLFNLN_begin 
Bkm_TOTLFNLN_end 

To print the multiple TO persons details in the following format: 
1st To Person Title + “ “ + LastName 
2nd To Person Title + “ “ + LastName 
 

Bkm_TOTLLN_begin 
Bkm_TOTLLN_end 

To print the multiple TO persons details in the following format: 
1st To Person Company 
2nd To Person Company 
 

Bkm_TOCOMPANY_begin 
Bkm_TOCOMPANY_end 
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To print the multiple TO persons details in the following format: 
1st To Person FirstName + “ “+ LastName + “, “ + Company 
2nd To Person FirstName + “ “+ LastName + “, “ + Company 
 

Bkm_TOFNLNCOMPANY_begin 
Bkm_TOFNLNCOMPANY_end 

To print the multiple TO persons details in the following format: 
1st To Person Title + “ “ + FirstName + “ “+ LastName + “, “ + Company 
2nd To Person Title + “ “ + FirstName + “ “+ LastName + “, “ + Company 
 

Bkm_TOTLFNLNCOMPANY_begi
n 
Bkm_TOTLFNLNCOMPANY_end 

To print the multiple TO persons details in the following format: 
1st To Person FaxNo 
2nd To Person FaxNo 

Bkm_TOFAX_begin 
Bkm_TOFAX_end 

 
Notes: 
 
To print the CC persons details replace the ‘TO’ (in blue) with ‘CC’ 
 
Eg:  bkm_CCFNLNCOMPANY_begin 

bkm_CCFNLNCOMPANY_end 
 
 
To print the 2nd TO person onwards and all CC persons details replace the ‘TO’ (in blue) with ‘TOCC’ 
 
Eg:  bkm_TOCCFNLNCOMPANY_begin 

bkm_TOCCFNLNCOMPANY_end 
 
 
C. Bookmarks names to get only ONE persons TO Details 
 
Description Bookmarks 
FirstName + “ “+ LastName 
 

bkm_pcmlToName_begin 
bkm_pcmlToName_end 

Title 
 

bkm_RfAdrBook_Title_begin 
bkm_RfAdrBook_Title_end 

First Name 
 

bkm_RfAdrBook_FirstName_begin 
bkm_RfAdrBook_FirstName_end 

Last Name 
 

bkm_RfAdrBook_LastName_begin 
bkm_RfAdrBook_LastName_end 

Position 
 

bkm_RfAdrBook_Position_begin 
bkm_RfAdrBook_Position_end 

Company bkm_pcMlToCompany_begin 
bkm_pcMlToCompany_end 

Full Address bkm_pcMlToAdr_begin 
bkm_pcMlToAdr_end 

Address Line 1 
 

bkm_RfAdrBook_Address1_begin 
bkm_RfAdrBook_Address1_end 

Address Line 2 
 

bkm_RfAdrBook_Address2_begin 
bkm_RfAdrBook_Address2_end 

PO Box 
 

bkm_RfAdrBook_PostalAdr_begin 
bkm_RfAdrBook_PostalAdr_end 

City 
 

bkm_RfAdrBook_City_begin 
bkm_RfAdrBook_City_end 

State 
 

bkm_RfAdrBook_State_begin 
bkm_RfAdrBook_State_end 

Post Code 
 

bkm_RfAdrBook_PostCode_begin 
bkm_RfAdrBook_PostCode_end 

Country bkm_RfAdrBook_Country_begin 
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 bkm_RfAdrBook_Country_end 
Telephone bkm_pcMlToTel_begin 

bkm_pcMlToTel_end 
Fax bkm_pcMlToFax_begin 

bkm_pcMlToFax_end 
Mobile 
 

bkm_RfAdrBook_PhoneMob_begi
n 
bkm_RfAdrBook_PhoneMob_end 

Barcode 
 

bkm_RfAdrBook_Barcode_begin 
bkm_RfAdrBook_Barcode_end 

Email bkm_pcMlToEml_begin 
bkm_pcMlToEml_end 

 
 
D. Bookmarks names to get the FROM persons Details 
 
Description Bookmarks 
FirstName + “ “+ LastName bkm_PCMLFromName_begin 

bkm_ PCMLFromName _end 
Title 
 

bkm_RfAdrBook1_Title_begin 
bkm_RfAdrBook1_Title_end 

First Name 
 

bkm_RfAdrBook1_FirstName_begin 
bkm_RfAdrBook1_FirstName_end 

Last Name 
 

bkm_RfAdrBook1_LastName_begin 
bkm_RfAdrBook1_LastName_end 

Position 
 

bkm_RfAdrBook1_Position_begin 
bkm_RfAdrBook1_Position_end 

Company bkm_pcMlFromCompany_begin 
bkm_pcMlFromCompany_end 

Full Address bkm_pcMlFromAdr_begin 
bkm_pcMlFromAdr_end 

Telephone bkm_pcMlFromTel_begin 
bkm_pcMlFromTel_end 

Address Line 1 
 

bkm_RfAdrBook1_Address1_begin 
bkm_RfAdrBook1_Address1_end 

Address Line 2 
 

bkm_RfAdrBook1_Address2_begin 
bkm_RfAdrBook1_Address2_end 

PO Box 
 

bkm_RfAdrBook1_PostalAdr_begin 
bkm_RfAdrBook1_PostalAdr_end 

City 
 

bkm_RfAdrBook1_City_begin 
bkm_RfAdrBook1_City_end 

State 
 

bkm_RfAdrBook1_State_begin 
bkm_RfAdrBook1_State_end 

Post Code 
 

bkm_RfAdrBook1_PostCode_begin 
bkm_RfAdrBook1_PostCode_end 

Country 
 

bkm_RfAdrBook1_Country_begin 
bkm_RfAdrBook1_Country_end 

Fax bkm_pcMlFromFax_begin 
bkm_pcMlFromFax_end 

Mobile 
 

bkm_RfAdrBook1_PhoneMob_begi
n 
bkm_RfAdrBook1_PhoneMob_end 

Barcode 
 

bkm_RfAdrBook1_Barcode_begin 
bkm_RfAdrBook1_Barcode_end 

Email bkm_pcMlFromEml_begin 
bkm_pcMlFromEml_end 
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E. Bookmarks prefixes to control the DATE format 
 
Description Bookmarks 
To print date as DD/MM/YY say for the DATED field bkm_DMY_RfMail_Dated_begin 

bkm_DMY_RfMail_Dated_end 
To print date as DD/MM/YYYY say for the DATED field bkm_DMYY_RfMail_Dated_begin 

bkm_DMYY_RfMail_Dated_end 
To print date as 20 March 2003 say for the DATED 
field 

bkm_DCMYY_RfMail_Dated_begin 
bkm_DCMYY_RfMail_Dated_end 

To print date as Thursday, 20th March 2003 say for the 
DATED field 

bkm_CDDCMyY_RfMail_Dated_begin 
bkm_CDDCMYY_RfMail_Dated_end 

 
 
F. Bookmark names for the Project Details 
 
Description Bookmarks 
Project Company name Bkm_ga_cCompany_begin 

bkm_ga_cCompany_end 
Project Company Address 1 Bkm_ga_cAddress1_begin 

bkm_ga_cAddress1_end 
Project Company Address 2 Bkm_ga_cAddress2_begin 

bkm_ga_cAddress2_end 
Project Company Address 1 + Address2 Bkm_ga_cFullAddress_begin 

bkm_ga_cFullAddress_end 
Project Company City  bkm_ga_cCity_begin 

bkm_ga_cCity_end 
Project Company State bkm_ga_cState_begin 

bkm_ga_cState_end 
Project Company PostCode bkm_ga_cPostCode_begin 

bkm_ga_cPostCode_end 
Project Company City + “ “ + State + “ “ + PostCode bkm_gt_cCityStatePostCode_begi

n 
bkm_gt_cCityStatePostCode_end 

Project Company Phone Bkm_ga_cPhone_begin 
bkm_ga_cPhone_end 

Project Company Fax Bkm_ga_cFax_begin 
bkm_ga_cFax_end 

Project Company Email Bkm_ga_cEmail_begin 
bkm_ga_cEmail_end 

Project Company Internet  bkm_ga_cInternet_begin 
bkm_ga_cInternet_end 

 


